
 PHY 

 7a 

© 2009 Vernier Software & Technology 1 

 

Introduction to the Vernier Photogate: 
Part 1 – Gate Timing 

The Vernier Photogate is a general sensor used for measuring speeds, accelerations, and periods 
of moving objects. It can also be used for freefall, projectile motion, and pendulum experiments. 
The Photogate works by projecting an infrared beam to a sensor. When the beam is blocked the 
sensor stops sending a signal, which illuminates an LED on the top of the gate as well as 
triggering the data collection software to display a blocked message in the data collection area. 
The sensor has several different modes of use that are important to understand. The following 
activity will help you become familiar with the usage of the Vernier Photogate in Gate Timing 
mode. 

The LabQuest application can use the time associated with blocked and unblocked 
events to calculate distance traveled, speed, and acceleration. For Gate Timing 
mode, timing will begin when the Photogate is first blocked. The timing will 
continue until the gate is unblocked. The duration of the interruption is thus timed 
and reported. If the length of the object is entered, the velocity is also calculated.  

OBJECTIVES 

In this experiment, you will 
 Practice using the Vernier Photogate in Gate Timing mode. 

 Collect and interpret sample data from a Vernier Photogate. 

 
 
MATERIALS 

LabQuest meter stick or metric ruler 
Vernier Photogate marble or large ball bearing 

 
 
PROCEDURE 

1. Connect a Vernier Photogate to the DIG1 port on the LabQuest. Verify that the shutter on the 
inside of the thinner Photogate arm is open. 

2. Turn on your LabQuest and select New from the File menu. 

3. Verify that the Photogate is working by placing your hand in the Photogate beam. The red 
LED light on the top of the gate should illuminate and the LabQuest App will display 
Blocked. Remove your hand and verify the light goes out and the LabQuest App displays 
Unblocked. 

Part 1 – General Investigations 

4. Tap on Timing and change the Photogate mode to None. Tap OK. 
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5. Start data collection and block the Photogate for a count of one. Unblock the Photogate and 
then block it again for a count of two. Unblock the Photogate and block it again for a count 
of three. Stop data collection. What does the data show you? Does the graph make sense?  

 

 

6. Spread your fingers apart to form a “W”. Do this by spreading your index finger and pinky 
apart while keeping your middle and ring fingers together. Sketch what you would expect the 
graph to look like if you moved your hand through the Photogate in one direction and then 
back through in the opposite direction. Test your hypothesis by collecting the data.  

 

 

 

 

 
7. From the Meter view, tap on Timing. Select to have data collection end after 8 events. Tap 

OK to save the settings. 

8. Start data collection and run your finger through the photogate. Do this until data collection 
ends. How many times did you have to move your finger through the photogate before data 
collection ended? Look at the data table and make a guess as to what is meant by an “Event” 
in the “end after 8 events” setting. 

 

 

 

 

 

Part 2 – Investigating Gate Mode 

9. From the Meter view, tap on Timing. Change the Photogate mode to Gate. Enter 1.0 m for 
the object length.  

 10. Start data collection and block the Photogate for a count of one. Unblock the Photogate and 
then block it again for a count of two. Unblock the Photogate and block it again for a count 
of three. Unblock the Photogate and block it again for a count of four. What does the data 
show you? Do the calculated values make sense for an object with a length of one meter? 

 

 

 11. Measure the width of the Photogate support rod in meters. Go back to the Meter view and tap 
on Timing. Enter the width as the object length. 

 12. Invert the Photogate, open side up, and practice passing the support rod through the 
Photogate. Try to keep the rod vertical as it passes through the gate and be sure the rod is 
moving perpendicular to the Photogate beam. 
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 13. Start data collection. Pass the support rod through the gate. Continue passing the rod through 
the gate trying different speeds until data collection ends. The graphs will show the support 
rods velocities as you passed it through the gate. Do the velocities make sense? 

 

 

 14. Adjust the setup to measure the speed of a marble rolling through the Photogate beam. What 
values did you enter for the setup? Be prepared to discuss the accuracy of the measurements 
you get.  
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Introduction to the Vernier Photogate: 
Part 2 – Pulse Timing 

The Vernier Photogate is a general sensor used for measuring speeds, accelerations, and periods 
of moving objects. It can also be used for freefall, projectile motion, and pendulum experiments. 
The Photogate works by projecting an infrared beam to a sensor. When the beam is blocked the 
sensor stops sending a signal, which illuminates an LED on the top of the gate as well as 
triggering the data collection software to display a blocked message in the data collection area. 
The sensor has several different modes of use that are important to understand. The following 
activity will help you become familiar with the usage of the Vernier Photogate in Pulse Timing 
mode. 

Pulse Timing will begin when the Photogate is first blocked. With Pulse 
Timing, the timing will continue until the gate is blocked again. This 
mode is typically used with two Photogates. 

OBJECTIVES 

In this experiment, you will 
 Practice using the Vernier Photogate in Pulse Timing Mode. 

 Collect and interpret sample data from a Vernier Photogate. 

 
 
MATERIALS 

LabQuest meter stick 
2 – Vernier Photogates marble or large ball bearing 

 
 
PROCEDURE 

1. Connect a Vernier Photogate to the DIG1 port on the LabQuest. Verify that the shutter on the 
inside of the thinner Photogate arm is open. 

2. Turn on your LabQuest and select New from the File menu. 

3. Verify that the Photogate is working by placing your hand in the Photogate beam. The red 
LED light on the top of the gate should illuminate and the LabQuest App will display 
Blocked. Remove your hand and verify the light goes out and the LabQuest App displays 
Unblocked. 

4. Tap on Timing and change the Photogate mode to Pulse. Set the distance between gates to 
be 1.0 meter. Select to have data collection end after 4 events. Tap OK. 

 5. Start data collection and pass your finger through the Photogate twice. Notice that the pulse 
time and velocity are displayed. 

 6. Repeat step 5 several times varying the time between blockings. 
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Part 1 – Two Photogates Daisy-chained Together 

 7. Connect a second Photogate to the first Photogate. This configuration is called daisy-
chaining. Place the second Photogate 1.0 meter from the first Photogate. Describe how you 
measured this distance. 

 

 

 8. Tap on the Meter view. How many Photogates are listed in this view? What happens when 
you place your finger to block the new Photogate? 

 

 

 9.  Repeat steps 5 and 6, this time pass your finger through both Photogates. Does it matter 
which Photogate you pass your finger through first? How do you know? 

 

 

 10. Hold your index and middle finger to form a “V”. Describe what you get if you pass the V 
through both Photogates. Is the velocity displayed consistent with the average speed of your 
hand traveling the 1.0 meter distance between the Photogates? Explain your thinking. 

 

 

 

Part 2 – Two Photogates connected to a LabQuest 

 11. Tap on the Table view. From the Table menu, select Clear All Data. 

 12. Tap on the Meter view. Disconnect the second Photogate from the first and connect it to 
DIG2 of your LabQuest. How many Photogates are listed in this view? What happens when 
you place your finger to block the different Photogates? 
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 13. Repeat steps 5 and 6, this time pass your finger through both Photogates. Does it matter 
which Photogate you pass your finger through first? How do you know? 

 

 

 14. Hold your index and middle finger to form a “V”. Describe what you get if you pass the V 
through both Photogates. Is the velocity displayed consistent with the average speed of your 
hand traveling the 1.0 meter distance between the Photogates? Explain your thinking. 

 

  

 15. Go back to the Meter view and tap on Timing. Change the setting to have data collection end 
after 8 events. Repeat step 14. Does this set up work as you expect? Explain. 

 

 

 16. Spread your fingers apart to form a “W”. Do this by spreading your index and pinky fingers 
apart while keeping your middle and ring fingers together. Would the current setup determine 
the average speed of your hand while it is traveling the 1.0 meter distance between the 
Photogates? What if all of your fingers were separated? Test your hypotheses and be 
prepared to explain. 

 

 

 17. Based on your investigation from steps 14 – 16, explain the necessary conditions for the 
software to return a pulse time when using two photogates connected directly to a LabQuest. 

 

 

 

 18. Adjust the setup to measure the speed of a marble rolling through two Photogates placed next 
to each other. What values did you enter for the setup? Be prepared to discuss the accuracy of 
the measurements you get.  
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Introduction to the Vernier Photogate: 
Part 3 – Pendulum Timing 

The Vernier Photogate is a general sensor used for measuring speeds, accelerations, and periods 
of moving objects. It can also be used for freefall, projectile motion, and pendulum experiments. 
The Photogate works by projecting an infrared beam to a sensor. When the beam is blocked the 
sensor stops sending a signal, which illuminates an LED on the top of the gate as well as 
triggering the data collection software to display a blocked message in the data collection area. 
The sensor has several different modes of use that are important to understand. The following 
activity will help you become familiar with the usage of the Vernier Photogate in Pendulum 
Timing mode. 

The Pendulum Timing mode uses a single Photogate. The timing 
will begin when the Photogate is first blocked. The timing will 
continue until the Photogate is blocked twice more. 

OBJECTIVES 

In this experiment, you will 
 Practice using the Vernier Photogate in Pendulum Timing Mode. 

 Collect and interpret sample data from a Vernier Photogate. 

 
 
MATERIALS 

LabQuest 500-g hooked mass 
Vernier Photogate string 

 
 
PROCEDURE 

1. Connect a Vernier Photogate to the DIG1 port on the LabQuest. Verify that the shutter on the 
inside of the thinner Photogate arm is open. 

2. Turn on your LabQuest and select New from the File menu. 

3. Verify that the Photogate is working by placing your hand in the Photogate beam. The red 
LED light on the top of the gate should illuminate and the LabQuest App will display 
Blocked. Remove your hand and verify the light goes out and the LabQuest App displays 
Unblocked. 

 4. Tap on Timing and change the Photogate mode to Pendulum. Tap OK. 

 5. Start data collection and move your finger through the Photogate repeatedly. Notice that after 
the first blocking, the data collection software reports the time interval between every other 
block as the period. 
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 6. Repeat step 5, this time start with the Photogate blocked. Does this affect when the period is 
calculated. Hint: look at the data in the table. 

 

 

 7. Hold your hand to form a “W”. Do this by holding your index and pinky fingers spread out 
while keeping your middle and ring fingers together. If you pass this W through the 
Photogate, will a period measurement be recorded? Explain. 

 

 

 8. Begin data collection again and pass your finger through the Photogate in a regular period. 
Perform five complete passes and stop data collection. Select Statistics from the Analyze 
menu and tap on Period. What average period did you get? How would you change your 
motion to have a higher period? Lower? 

 

 

 9. Repeat step 7 using the 500-g hooked mass on a string as your pendulum.  

 

 

 10. Adjust the Pendulum mode setup to measure exactly 10 periods of an oscillating pendulum. 
What settings did you use? 

 

 

 11. Does it matter where in the pendulum’s swing you place the photogate in order to measure 
the period? Explain your reasoning. 
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Introduction to the Vernier Photogate: 
Part 4 – Gate & Pulse Timing 

The Vernier Photogate is a general sensor used for measuring speeds, accelerations, and periods 
of moving objects. It can also be used for freefall, projectile motion, and pendulum experiments. 
The Photogate works by projecting an infrared beam to a sensor. When the beam is blocked the 
sensor stops sending a signal, which illuminates an LED on the top of the gate as well as 
triggering the data collection software to display a blocked message in the data collection area. 
The sensor has several different modes of use that are important to understand. The following 
activity will help you become familiar with the usage of the Vernier Photogate in Gate & Pulse 
Timing mode. 

Gate and Pulse Timing is accomplished by combining the process of a gate timer, measuring the 
time a Photogate is blocked, with pulse timing, measuring the time between successive blockings 
of the Photogates. This allows the measurement of the velocity of an object at each gate, and the 
acceleration the object is undergoing by using the velocities and the time measured for the object 
between Photogates. Two Photogates are used in this mode. 

OBJECTIVES 

In this experiment, you will 
 Practice using the Vernier Photogate in Gate & Pulse Timing mode. 

 Collect and interpret sample data from a Vernier Photogate. 

 
 
MATERIALS 

LabQuest meter stick or metric ruler 
2 – Vernier Photogates  

 
 
PROCEDURE 

1. Connect a Vernier Photogate to the DIG1 port on the LabQuest. Connect a second Photogate 
to DIG2 of your LabQuest. Verify that the shutter on the inside of the thinner Photogate arm 
is open for both photogates. 

2. Turn on your LabQuest and select New from the File menu. 

3. Verify that the Photogates are working by placing your hand in the Photogate beam of each 
Photogate. The red LED light on the top of the gate should illuminate and the LabQuest App 
will display Blocked. Remove your hand and verify the light goes out and the LabQuest App 
displays Unblocked. 

Part 1 – Two Photogates connected to a LabQuest 

 4. Tap on Timing and change the Photogate mode to Gate and Pulse. Enter the width of the 
Photogate support rod as the length of the object. Tap OK.  
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 5. Invert the Photogates on the table and place them about 0.5 meters apart. Exact distance is 
not imperative. Start data collection. Pass the support rod through the first Photogate and 
continue through the second. Repeat at least four more times varying the velocities and the 
time between Photogates. Stop Data Collection. 

 6. How does the software determine acceleration without knowing the distance between the 
Photogates? (Hint: what is the definition of acceleration?) 

 

 

 7. Does it matter which Photogate you pass through first? Explain your reasoning. 

 

 

 8. Hold your index and middle finger to form a “V”. Pass the V through both Photogates and 
observe the measurements? What exactly is being measured? (Hint: look at the data in the 
table.) 

 

 

Part 2 – Two Photogates Daisy-chained Together 

 9. Tap on the Table view. From the Table menu, select Clear All Data. 

 10. Disconnect the photogate from DIG2 and connect it directly to the photogate in DIG1. This 
configuration is called daisy-chaining. 

 11. Repeat step 5 with the Photogates daisy-chained together. Does Gate & Pulse mode work the 
same for Photogates that are daisy-chained together as it does for photogates connected 
directly to a LabQuest? Explain your reasoning. 
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Introduction to the Vernier Photogate: 
Part 5 – Motion Timing 

The Vernier Photogate is a general sensor used for measuring speeds, accelerations, and periods 
of moving objects. It can also be used for freefall, projectile motion, and pendulum experiments. 
The Photogate works by projecting an infrared beam to a sensor. When the beam is blocked the 
sensor stops sending a signal, which illuminates an LED on the top of the gate as well as 
triggering the data collection software to display a blocked message in the data collection area. 
The sensor has several different modes of use that are important to understand. The following 
activity will help you become familiar with the usage of the Vernier Photogate in Motion Timing 
mode. 

The default Timing Setting for the Photogate is Motion 
Timing. During operation, times are recorded as leading 
opaque edges of a "picket fence," bar tape, or a pulley 
spoke pass through the Photogate beam. More importantly, 
if you enter the distance between the leading edges of the 
opaque bands (d in the figure) in the Length of Object 
field, the program can analyze the times, and calculate 
velocities, displacements, and accelerations. 

OBJECTIVES 

In this experiment, you will 
 Practice using the Vernier Photogate in Motion Timing mode. 

 Collect and interpret sample data from a Vernier Photogate. 

 
 
MATERIALS 

LabQuest Vernier Picket Fence 
Vernier Photogate Vernier Ultra Pulley 
meter stick or metric ruler  

 
 
PROCEDURE 

1. Connect a Vernier Photogate to the DIG1 port on the LabQuest. Verify that the shutter on the 
inside of the thinner Photogate arm is open. 

2. Turn on your LabQuest and select New from the File menu. 

3. Verify that the Photogate is working by placing your hand in the Photogate beam. The red 
LED light on the top of the gate should illuminate and the LabQuest App will display 
Blocked. Remove your hand and verify the light goes out and the LabQuest App displays 
Unblocked. 
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Part 1 – Motion Timing with a Picket Fence 

 4. Tap on Timing and note that the default setting for a Photogate is Motion Timing using a 
Vernier Picket Fence. Data Collection is set to stop after 16 events, which corresponds to 
the eight bands on the picket fence passing through the Photogate. Tap OK. 

 5. Invert the Photogate and start data collection. Take your hand and spread your 4 fingers apart 
and pass them through the Photogate. Quickly repeat the pass with your fingers. This gives 
16 events to analyze. Look at your distance graph. Why does the distance increase? What is 
being measured? (Hint: look at the table.) 

  

 

 

 6. Start data collection again. Take a picket fence and hold it by the top edge lengthwise. Pass 
the picket fence through the Photogate at a constant velocity, as level as possible. What can 
you determine from the graph of your motion with the picket fence? 

 

 

 

 7. Repeat step 6, but vary the speed as you pass the picket fence through the gate. What does 
your graph look like now? Does it match your motion? Explain. 

 

 

 

Part 2 – Motion Timing with an Ultra Pulley 

 8. Attach the Vernier Ultra Pulley to the Photogate using the Photogate support rod. 

 9. From the Meter view, tap on Timing. Change the setup to reflect using the Pulley (10 spoke) 
measuring distances using the Outside Edge. Note that the End Data Collection is set to end 
with the Stop button for this mode. Tap OK to save the settings. 

 10. Gently spin the pulley, then start data collection. What information is presented? What 
happens to the distance and velocity as the wheel slows down? 

 

 

 11. Repeat step 10, this time spinning the pulley in the opposite direction. Does it matter which 
way the pulley spins? Explain. 
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 12. Hold the photogate support rod so that pulley can be rolled along the table surface. Make 
sure the cable will not interfere with the rolling. Place the pulley next to a meter stick that is 
lying on the table so that the center of the wheel is aligned with one end of the meter stick. 
Start data collection and roll the pulley with a slow and steady rate along the meter stick until 
the pulley reaches the other end of the meter stick. Do the distance and velocity graphs make 
sense for this motion? Explain. 

 

 

 13. Repeat step 12, this time varying your speed. How are the results different? 

 

 

 14. Repeat step 12, this time rolling the pulley backwards (relative to the previous) along the 
meter stick. Based on your results, does the direction the pulley spins matter? Explain your 
reasoning. 

 

 

 15. Repeat step 12, this time start with the pulley at the 0 cm mark, roll it until you get to the 75 
cm mark, stop for a count of 2, roll it backwards to the 25 cm mark, stop for a count of 2, and 
then roll the pulley forward to the 100 cm mark. Based on the graph, does the Photogate and 
Ultra Pulley measure distance traveled or displacement? Explain how you know.  

 

 

 

 16. Sketch graphs of your distance, velocity and acceleration data. Do the graphs make sense for 
the motion described? Explain your reasoning. 
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Introduction to the Vernier Photogate:  

PART 1 – GATE TIMING 

• One possible drawback to this mode is that the Photogate lens has to be positioned on the 
largest length. For example, the middle part of a ball, your finger, or the body of a toy car. If 
it is not positioned correctly, incorrect time data will be collected, resulting in skewed 
velocity and acceleration data. 

Answers to Questions 

5. The graph shows increasing amounts of time for the photogate to be blocked. A blocked 
photogate is represented as 1 and unblocked is represented as 0. 

 
 
6. The sample graph was created with the index finger entering the beam first. From the graph 

you can tell that the spacing between the index finger and the middle finger is less than the 
spacing between the pinky finger and the ring finger. The middle and ring fingers blocked the 
beam the longest, followed by the index finger, and the pinky finger.  
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8. Data collection ends after four passes through the gate. The data table has eight entries, 4 
blocked and 4 unblocked events. The blocked and unblocked occur in pairs starting with 
blocked. An Event is a change in photogate state (blocked to unblocked or unblocked to 
blocked). 

 10. The calculated values make since as the longer the gate was blocked, the slower the velocity 
value. 

 
 

 13. The values will make sense as the faster the rod passes through the gate, the higher the 
velocity. 

 14. The important measurement here is the width of the marble. Typically the diameter of the 
marble is used. To get the most accurate measurement possible, the width of the marble at the 
height of photogate shutter should be used. This makes using spherical objects difficult to use 
as a target with a photogate. 

 
PART 2 – PULSE TIMING 

Answers to Questions 

6. If the students have done gate mode first, this mode may seem a little strange at first. 
Velocities do not solely depend on how fast your finger moves through the gate, they 
depended on how much time there is between the time you first break the beam until you 
break it again by passing you finger through the gate a second time. 

7. The distances from the center of the first photogate to the center of the second must be 1 
meter. 

8. There will only be one photogate listed on the Meter screen. Blocking either photogate will 
cause the gate state to change. Although you are using two photogates, the software treats 
them as a single photogate. 

9. It does not matter which direction you move through the photogates. 

 10. The reading you get is not the average speed of your hand between the two photogates. This 
is because the second finger of the V will cause a second blocked event, which will be used 



 Introduction to the Vernier Photogate: Teacher Information 

© 2009 Vernier Software & Technology 3 T 

to calculate velocity using 1.0 meter for the distance. The velocity reported would be much 
larger than expected. 

 12. There are two photogates listed in the Meter view. Each one is independent of the other. 

 13. The direction you pass your fingers through the gate does matter. The pulse is measured 
using the time between the breaking of the beam in photogate 1 (DIG1) and the time in 
breaking photogate 2 (DIG2).  

 14. No measurements (pulse or velocity) will be reported since the four events will occur before 
your hand ever gets to the second photogate.  

 15. This configuration will report a single pulse and velocity corresponding to the time the 
leading finger passes through each gate. The events associated with the second finger are 
ignored. 

 16. The stop after 8 events works with “W” configuration as passing your hand through one gate 
will consist of only 6 events, allowing for the leading finger to break the beam on the second 
gate. If all fingers are separated, no measurements will be shown as passing your hand 
through one gate will consist of all 8 events. 

 17. To return a pulse time, a blocked event must occur at gate one (DIG1) followed by a blocked 
event at gate 2 (DIG2). If the target consists of more than one “flag” (finger), then the “stop 
after events” value has to be large enough to ensure the second gate is blocked before the 
number has been reached. 

 18. The important measurement here is the distance between photogate shutters. If you place the 
photogates so the labels are touching, the distance would be 0.02 m. This will give accurate 
measurements for the speed of the marble since the speed measurement does not depend on 
the marble’s size. 

 
PART 3 – PENDULUM TIMING 

Answers to Questions 

6. The period is calculated base on the time between the first blocked event followed by the 
third blocked event. If the photogate is blocked when data collection starts, the first event 
will be an unblocked event. This event starts data collection but its time is not used to 
calculate the period. 

7. Passing the W through the photogate will have a period measurement recorded. This is 
because the W consists of three blocked events. 

8. The period of an oscillating motion is the time for one complete oscillation. To make the 
period larger, you would need to slow down the time it takes to break the beam three times. 
To make the period smaller, you would need to speed up the motion. 

9. For the pendulum, the length of the sting will affect the period. A shorter pendulum will 
swing faster giving a smaller period. A longer pendulum will have a slower swing giving a 
larger period. 
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 10. Each full swing of the pendulum consists of five events (b-u-b-u-b). The blocked event, 
which corresponds to the end of one period, will double as the start of the next period for 
every swing except the first. To measure the period of ten swings, you would need to end 
after 41 events (42 if you start data collection when the photogate is blocked). 

 11. The pendulum must completely pass through the photogate in order for an unblocked event 
to be recorded each time it passes through the gate. If the photogate is placed near the top of 
the swing, the pendulum may not pass all the way through the gate.  

 
PART 4 – GATE & PULSE TIMING 

Answers to Questions 

6. Acceleration is defined as Δ velocity/Δ time. Using the principles from gate timing, the time 
for an object to pass through a single gate is determined. Using the width of object, the 
objects velocity can be determined at each gate. Using the principles from pulse timing, the 
time it takes the object to go from one gate to the next can be determined (Δt). Subtracting 
the two velocity values and dividing the result by the pulse time will give you the average 
acceleration between the gates. 

7. The gate you pass through first does matter in Gate and Pulse Timing. Velocity 
measurements are calculated for any pass through the gate but change in velocity and 
acceleration only happen when gate 2 (DIG2) is blocked after gate 1 (DIG1) has been 
blocked. 

8. Each time a finger passes through a gate, the time the gate is blocked is reported and a 
velocity is determined. The change in velocity and acceleration are calculated based on the 
blocking of gate 1 followed by the blocking of gate 2. 

 11. Gate & Pulse Timing for two photogates daisy-chained together does not behave the same as 
it does when the two photogates are connected directly to a LabQuest. Change in velocities 
and accelerations are not calculated. When using a single or daisy-chained photogates with 
Gate & Pulse mode, you will get a modified Gate Timing mode with an additional column 
for Midpoint time, the average of the times for a blocked and subsequent unblocked event as 
an object passes through the gate. 

 
PART 5 – MOTION TIMING 

• When a picket fence or bar tape is used, the width of each of the bands (b in the figure) 
should be at least 0.5 cm, the distance between the leading edges (d in the figure) should be 
at least 3 cm or larger if the picket fence is to be moving rapidly (for example in the free fall 
experiment). A closer spacing can be used if the object will be moving slowly; for example, 
on an air track glider. Motion timing uses the block-to-block timing interval for most 
calculations.  
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Answers to Questions 

5. In Motion Timing, distance, velocity, and acceleration are measured. The software calculates 
distance based on the assumption that all objects are a fixed distance apart. Velocity and 
acceleration are measured in the same way acceleration is measured in Gate & Pulse Timing. 

 

6. The position vs. time graph should be linear and the velocity vs. time graph horizontal. The 
displacement should correspond to the distance between the first and last black bands. 

 

7. The graph should show accelerated motion – non-linear position vs. time graphs and 
changing velocity vs. time graphs. The graphs should match the motion. 
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 10. Position vs. time and velocity vs. time graphs are shown. As the wheel slows down, the 
velocity gets smaller and the position does not increase as much. The graphs should be 
consistent with motion of an object that is undergoing negative acceleration while still 
moving in a positive direction. 

 

 11. The direction the pulley spins does not matter. The graphs should be similar to the ones from 
question 10. 

 12. The graphs should make sense given your motion. 

 

 13. The graphs show accelerated motion but the final positions should be the same. 
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 14. Like in question 11, the direction of the pulley spin does not matter. 

 15. The pulley travels a total of 2 meters but the displacement is only one meter. The graphs are 
showing distance traveled, not displacement, as there is no way for the software to determine 
the direction of the rotation of the pulley. 

 16. If you consider the graphs to represent distance traveled vs. time, speed vs. time, and (scalar) 
acceleration vs. time, the graphs make sense. They do not make sense if you consider the 
vector equivalent of the graphs (displacement vs. time, velocity vs. time, and acceleration vs. 
time).  

 

 

 


